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License

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology 
is incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.

Precautions When Displaying a Still Image
A still image may cause permanent damage to the TV screen

Do not display still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as “screen burn”. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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English - �

CONNECTING AND PREPARING YOUR TV

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice in order to enhance product performance.

Viewing the Control Panel
The product colour and shape may vary depending on the model.
The front panel buttons can be activated by touching them with your finger.

1 SPEAKERS
2 REMOTE CONTROL SENSOR

Aim the remote control towards this spot on the TV.
3 SOURCEE

Toggles between all the available input sources. In the on-screen menu, use this button as you would use the ENTERE 
button on the remote control.

4 MENU
Press to see an on-screen menu of your TV’s features.

5 – VOL +
Press to increase or decrease the volume.
In the on-screen menu, use the – VOL + buttons as you would use the ◄ and ► buttons on the remote control.

6 > CH <
Press to change channels. In the on-screen menu, use the > CH < buttons as you would use the ▼ and ▲ buttons on the 
remote control. 

7 POWER INDICATOR
Blinks and turns off when the power is on and lights up in stand-by mode.

8 P (POWER)
Press to turn the TV on and off.

N

¦

N
N

1 3 4 5 62 78
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English - �

Accessories

Remote Control & Batteries (AAA x 2) Power Cord Cleaning Cloth

(M4 X L16) (M4 X L14)

Cover-Bottom Stand Screw Stand Screw X 3
(32inch model only)

Owner’s Instructions ● Warranty card● Safety Guide● Registration Cards●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
Warranty card / Safety Guide / Registration Cards (Not available in all locations)
The items colour and shape may vary depending on the model.

Viewing the Connection Panel

The product colour and shape may vary depending on the model.
Whenever you connect an external device to your TV, make sure that power on the unit is turned off.
When connecting an external device, match the colour of the connection terminal to the cable.

1 HDMI IN �, HDMI IN �, HDMI IN �(DVI), HDMI IN 4
Supports connections between HDMI-connection-enabled AV devices (Set-Top Boxes, DVD players)
No additional Audio connection is needed for an HDMI to HDMI connection.
When using an HDMI / DVI cable connection, you must use the HDMI IN �(DVI) jack.

¦

N
N
N

¦

N
N
N

–
–
–
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[TV Side Panel]

[TV Rear Panel]

Power Input
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English - 4

What is HDMI?
‘High Definition Multimedia interface’ allows the transmission of high definition digital video data and multiple channels of 
digital audio.
The HDMI / DVI terminal supports DVI connection to an extended device with the appropriate cable (not supplied).
The difference between HDMI and DVI is that the HDMI device is smaller in size, has the HDCP (High Bandwidth Digital 
Copy Protection) coding feature installed, and supports multi - channel digital audio.
The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable 
Boxes / Satellite receivers supporting HDMI versions older than 1.3 are connected. When connecting an older HDMI 
cable and there is no sound, connect the HDMI cable to the HDMI IN �(DVI) jack and the audio cables to the DVI AUDIO 
IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / Cable Box / 
Satellite receiver to confirm the HDMI version, then request a firmware update. HDMI cables that are not 1.3 may cause 
annoying flicker or no screen display.
Supported modes for HDMI / DVI and Component.

480i 480p 576i 576p 720p 1080i 1080p
HDMI / DVI 50Hz X X X O O O O
HDMI / DVI 60Hz X O O X O O O

Component O O O O O O O

2 DVI AUDIO IN
DVI audio outputs for external devices.

3 PC IN [AUDIO], [PC]
Connect to the video and audio output jack on your PC.

4 ANT IN
To view television channels correctly, a signal must be received by the set from one of the following sources: An outdoor 
aerial / A cable television network

5 AUDIO OUT [R-AUDIO-L]
Connect RCA audio cables to AUDIO OUT [R-AUDIO-L] on the rear of your set and the other ends to corresponding 
audio in connectors on the Amplifier or DVD Home Theatre.

6 KENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place.
If you want to use a locking device, contact the dealer where you purchased the TV.
The location of the Kensington Lock may be different depending on its model.

7	H (HEADPHONE)
Headphone may be connected to the headphone output on your set. While the head phone is connected, the sound from 
the built-in speakers will be disabled.
Using the sound function is restricted when connecting headphones to the TV.
Prolonged use of headphones at a high volume may damage your hearing.
You will not hear sound from the speakers when you connect headphones to the TV.
The headphone volume and TV volume are adjusted separately.

8 DIGITAL AUDIO OUT (OPTICAL)
Connects to a Digital Audio component.
When a Digital Audio System is connected to the DIGITAL AUDIO OUT (OPTICAL) jack: Decrease the volume of the TV 
and adjust the volume level with the system’s volume control.
5.1CH audio is possible when the TV is connected to an external device supporting 5.1CH.

9 SERVICE
Connector for service only.

0 AV IN �, � [VIDEO] / [R-AUDIO-L]
Connect RCA cable to an appropriate external A/V device such as VCR, DVD or Camcorder.
Connect RCA audio cables to [R-AUDIO-L] on your set and the other ends to corresponding audio out connectors on the 
A/V device.

! COMPONENT IN �, �
Connect component video cables (optional) to component connector (PR, PB, Y) on the rear of your set and the other ends 
to corresponding component video out connectors on the DVD.
If you wish to connect both the Set-Top Box and DVD, you should connect the Set-Top Box to the DVD and connect the 
DVD to component connector (PR, PB, Y) on your set.
The PR, PB and Y connectors on your component devices DVD are sometimes labeled Y, B-Y and R-Y or Y, Cb and Cr.
Connect RCA audio cables (optional) to [R-AUDIO-L] on the rear of your set and the other ends to corresponding audio 
out connectors on the DVD.

@ USB
Connector for Media Play, etc.

N

N

N

–

–

–

–

–
–
–

–
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Viewing the Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1 POWER : Turns the TV on and off.
2 NUMERIC BUTTONS :  Press to 

change the channel.
3 E : Performs the same function 

as the ENTERE button of 
the directional buttons. When 
switching channels with the 
numeric buttons, and you press 
the channel number and then the 
ENTERE button, the channel is 
immediately switched.

4 Y : Press to increase or 
decrease the volume.

5 SOURCE : Press to display and 
select the available video sources.

6 CH LIST : Used to display 
Channel Lists on the screen.

7 TOOLS : Use to quickly select 
frequently used functions.

8 INFO : Press to display information 
on the TV screen.

9 COLOUR BUTTONS : Use these 
buttons in the Channel list, Media 
Play menu, etc.

! DUAL : Sound effect selection
@ Use these buttons in the Media 

Play and Anynet+ modes. (∏: 
This remote can be used to control 
recording on Samsung recorders 
with the Anynet+ feature)

# TV : Selects the TV mode directly.
$ PRE-CH : Enables you to return 

to the previous channel you were 
watching.

% MUTE M : Press to temporarily 
cut off the sound. 

^ P </P > : Press to change 
channels.

& MENU : Displays the main on-
screen menu.

* FAV.CH : Used to display 
Favourites Channel Lists on the 
screen.

( RETURN : Returns to the previous 
menu

)	 UP▲	/	DOWN▼	/	LEFT◄	/	
RIGHT►	/	ENTERE : Use to 
select on-screen menu items and 
change menu values.

a EXIT : Press to exit the menu.
b P.SIZE : Picture size selection.
c MEDIA.P : Allows you to play 

music files and pictures.
d SUBT. : Digital subtitle display
e GUIDE : Electronic Programme 

Guide (EPG) display  
 

Teletext Functions
5 0 : Teletext mode selection 

(LIST / FLOF)
6 8 : Teletext store
7 4 : Teletext size selection
8 5 : Teletext reveal
9 Fastext topic selection
0 / : Alternately select 

Teletext, Double, or Mix.
# : : Exit from the Teletext display
$ 1: Teletext sub page
^ 2: Teletext next page

3: Teletext previous page
& 6 : Teletext index
( 9 : Teletext hold
a 7 : Teletext cancel

Installing Batteries in the Remote Control
�. Lift the cover at the back of the remote control upward as shown in the figure.
�. Install two AAA size batteries.

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

�. Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time.

If the remote control doesn’t work, check the following:
Is the TV power on?
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?

¦

N
N
N
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N
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OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select and adjust different functions.

  

Operation the OSD (On Screen Display)
The access step may differ depending on the selected menu.
�. Press the MENU button.

�. The main menu appears on the screen. The menu’s left side has icons : Picture, Sound, 
Channel, Setup, Input, Application, Support.

�. Press the ▲ or ▼ button to select one of the icons.

4. Then press the ENTERE button to access the icon’s sub-menu.
�. Press the ▲ or ▼ button to select the icon’s submenu.

�. Press the ◄ or ► button to decrease or increase the value of a particular item. The 
adjustment OSD may differ depending on the selected menu.

7. Press the ENTERE button to complete the configuration. Press the EXIT button to exit.

¦

❑

MENU Button
Display the main on-screen menu.

ENTERE / DIRECTION Buttons
Move the cursor and select an 

item. Select the currently selected 
item. Confirm the setting.

RETURN Button
Return to the previous menu.

EXIT
Exit the on-screen menu.

Mode : Standard 
Backlight : 8 
Contrast : 95
Brightness : 45
Sharpness : 50
Colour : 50
Tint (G/R) : G50/R50
Advanced Settings

Picture

Mode	 :	Standard	 ►
Backlight : 8 
Contrast : 95
Brightness : 45
Sharpness : 50
Colour : 50
Tint (G/R) : G50/R50
Advanced Settings

Picture

Help icon

 Backlight   8

U Move      L Adjust     E Enter     R Return
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Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
�. Press the POWER button on the remote control. 

The message Select ‘Home Use’ when installing this TV in your home. is 
displayed.
You can also use the POWERP button on the TV.

�. Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button.
We recommend setting the TV to Home Use mode for the best picture in your home 
environment.
Store Demo mode is only intended for use in retail environments.
If the unit is accidentally set to Store Demo mode and you want to return to Home 
Use (Standard): Press the Volume button on the TV. When the volume OSD is 
displayed, press and hold the MENU button on the TV for 5 seconds.

�. Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

4. Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.
Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
The channel search will start and end automatically.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set the Clock Mode. is displayed.

�. Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.
If you select Manual, Set current date and time is displayed.
If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock.

�. Press the ▲ or ▼ button to highlight the time zone for your local area. Press the ENTERE button. (Australia only)
7. The description for the connection method providing the best HD screen quality is displayed. Check the description and press 

the ENTERE button.
8. Press the ENTERE button to confirm your setting. The message Enjoy your TV. is displayed. When you have finished, 

press the ENTERE button.
Even if the ENTERE button is not pressed, the message will automatically disappear after several seconds.

If you want to reset this feature...
�. Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, then press the ENTERE button.
�. Press the ENTERE button again to select Plug & Play.
�. Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. (refer to page 19)
The Plug & Play feature is only available in the TV mode.

¦

N

N

N

N
N

●
●
●
N
N
N

N
N

N

N
N

Plug & Play
Select ‘Home Use’ when installing this TV in your 
home.

L Move      E Enter

Store Demo Home Use
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CHANNEL CONTROL

Configuring	the	Channel	Menu

Country
You can change the country.

The PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting 
Change PIN from the menu.
Some functions may not be supported depending on the selected country.

Auto Store
You can scan for the frequency ranges available to you (and availability depends on your 
country).
Automatically allocated programme numbers may not correspond to actual or desired 
programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.
Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button.
The Stop Auto Store? message will be displayed.
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel
Manual store for digital channels.

Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.

Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour	System	→	Auto	/	PAL	/	SECAM	/	NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound	System	→	BG	/	DK	/	I	/	L: Sets the sound system value using the ▲ or ▼ button.
Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.
Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.
Channel mode

P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

¦

❑
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Country	 	:	Australia	 ►
Auto Store
Manual Store
Full Guide
Mini Guide
Default Guide : Full Guide
Channel List
Channel Mode

Channel
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Full Guide / Mini Guide
The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 
of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 
becomes available.

You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 
descriptions.)
In New Zealand, If Digital Text is set to Enable, the EPG (Electronic Program Guide) will work. (refer to page 20)

 Full Guide
Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 
may be scrolled forwards or backwards in time.
Mini Guide
The information of each programme is displayed by each line on the current channel Mini Guide screen from the current 
programme onwards according to the programme starting time order.

Default Guide	→	Mini Guide / Full Guide
You can decide whether to display either the Mini Guide or the Full Guide when the GUIDE button on the remote control is 
pressed.

Channel List
For the detailed procedures on using the Channel List, refer to the page 10.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.
Added Ch.
Channels will be switched within the memorized channel list.
Favourite Ch.
Channels will be switched within the favourite channel list.

Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button.
Only Analogue TV channels can be fine tuned.

❑

O

N





❑

❑

O

❑





❑

N

N
N
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Using the Full / Mini Guide

Full Guide
DTV Cable 900 f tn                       15:39 Wed 16 Jan
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

900       f tn
901       ITV Play
902       Kerrang!
903       Kiss
903       oneword
903       Smash Hits!▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

            Watch         Information     Page    ■	Mini Guide				■ +�4 Hours				■ Exit

Mini Guide DTV Cable 900 f tn

Street Hypnosis
Booze Britain

2:00
2:30
5:00▼

Freshmen On Campus

            Watch             Information          Page								■	Full Guide									■ Exit

To... Then...
Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.
Exit the guide Press the blue button
If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press the 
◄, ► button to select Cancel Schedules, the scheduling is canceled with the clock icon gone. 
View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button.

Then press the INFO button when the programme of your choice is 
highlighted.
The programme title is on the upper part of the screen center. 

Please click on INFO button for the detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 
Information (HD / SD), Sound Modes, Subtitle or Teletext, Languages of Subtitle or Teletext and brief summary of the highlighted 
programme are included on the detailed information. “...” will be appeared if the summary is long.
Toggle between the Mini Guide or Full Guide Press the red button repeatedly.
In Full Guide
Scrolls backwards quickly (24 hours).
Scrolls forwards quickly (24 hours).

Press the green button repeatedly.
Press the yellow button repeatedly.

In Mini Guide
Display previous page quickly.
Display next page quickly.

Press the green button.
Press the yellow button.

Managing Channels
Using this menu, you can add / delete or set favourite channels and use the programme guide for digital broadcasts.
All Channels
Shows all currently available channels.
Added Channels
Shows all added channels.
Favourites
Shows all favourite channels.

To select the favourites channels you have set up, press the FAV.CH button on the remote 
control.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List 

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. You can perform the Add / Delete, Add to Favourite / Delete from 
Favourite or Lock / Unlock function for multiple channels at the same time. Select the required channels and press the 
yellow button to set all the selected channels at the same time.
TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Edit Channel Number, Sort, Select All (or Deselect All) or Auto Store menu. (The 
Option menus may differ depending on the situation.)
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A  0                  C --

A  �             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --

Added Channels

All        ■ Channel Type           ■ Zoom           ■ Select          T Tools
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Channel Status Display Icons
A : An Analogue channel. 
c : A channel selected by pressing the yellow button.
* : A channel set as a Favourite. 
( : A programme currently being broadcast.
\ : A locked channel.
) : A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted. 
The Add menu only appears for deleted channels.
You can also delete a channel to the Added Channels or Favourites menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

The * symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourite menu.
Press the TOOLS button to display the Tools menu. You can also set the Add to Favourite by selecting Tools → Add to 
Favourite.

Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. This function is available only when the Child Lock is 
set to On. (see page 19)

The PIN number input screen appears. Enter your 4 digit PIN number. 
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN, by selecting Change PIN from the menu.
The \ symbol will be displayed and the channel will be locked.

Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. (See page 18)

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown on Programmed menu.
Digital Programme Guide and Viewing Reservation
When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)
Channels can be labeled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be labeled.
Edit Channel Number (digital channels only) (Australia, Singapore only)

You can also edit the channel number by pressing the number buttons on the remote control.
Sort (analogue channels only)
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.
Select All / Deselect All

Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels by pressing the yellow button.
You can perform the Add / Delete, Add to Favourites / Delete from Favourites, or Lock / Unlock function for multiple channels 
at the same time. Select the required channels and press the yellow button to set all the selected channels at the same time.
The c mark appears to the left of the selected channels.
You can only select Deselect All when there is a selected channel.
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A  2                  C --

A  �             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Added Channels

All        ■ Channel Type           ■ Zoom           ■ Select          T Tools

Delete
Add to Favourite
Lock 
Timer Viewing
Edit Channel Name
Sort

▼
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Auto Store
For further details on setting up options, refer to page 8.
If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed)
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.
Change Info
Select to change a viewing reservation.
Cancel Schedules
Select to cancel a viewing reservation.
Information
Select to view a viewing reservation. (You can also change the reservation information.)
Select All
Select all reserved programmes.
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PICTURE CONTROL

Configuring	the	Picture	Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 
selecting Tools → Picture Mode.

Dynamic 
Selects the picture for increased definition in a bright room.
Standard
Selects the picture for the optimum display in a normal environment.
Natural
Selects the picture for an optimum and eye-comfortable display.

This function is not available in PC mode.
Movie
Selects the picture for viewing movies in a dark room. 

Backlight / Contrast / Brightness / Sharpness / Colour / Tint(G/R)
Your television has several setting options that allow you to control the picture quality.
Backlight
 Adjusts the brightness of LCD back light.
Contrast
Adjusts the contrast level of the picture.
Brightness
Adjusts the brightness level of the picture
Sharpness
Adjusts the edge definition of the picture.
Colour
Adjusts colour saturation of the picture.
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1 / 1 / 2009
13:59 5 TV1  Quincy, M.E
18:59 2 TV3  The Equalizer
20:59 2 TV3  McMillan & Wife

Programmed

									All											■	Zoom					■	Select				T Tools    E Information

Change Info
Cancel Schedules
Information
Select All

Mode	 :	Standard	 ►
Backlight : 8 
Contrast : 95
Brightness : 45
Sharpness : 50
Colour : 50
Tint (G/R) : G50/R50
Advanced Settings

Picture
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Tint(G/R)
Adjusts the colour tint of the picture.

Select a picture mode to be adjusted first. The adjusted values are saved for each picture mode.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint(G/R), the OSD will be adjusted 
accordingly.
In analogue TV, AV1, AV2 modes of the PAL system, you cannot use the Tint(G/R) Function.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is lowered, which will 
reduce the overall running cost.

Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous 
models.

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Dynamic Contrast, Gamma and White 
Balance from among the Advanced Settings items.

Black	Tone	→	Off	/	Dark	/	Darker	/	Darkest
You can select the black level on the screen to adjust the screen depth.
Dynamic	Contrast	→	Off	/	Low	/	Medium	/	High
You can adjust the screen contrast so that the optimal contrast is provided.
Gamma
You can adjust the Primary Colour (Red, Green, Blue) Intensity.
Colour Space
Colour Space is a colour matrix composed of red, green and blue colours. Select your favourite Colour Space to experience the 
most natural colour.

Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on programme sources.
Native: Native Colour Space offers deep and rich colour tone.

White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset / G-Offset / B-Offset / R-Gain / G-Gain / B-Gain: You can adjust the Colour ‘temperature’ in the light areas by 
changing the values of R, G, B, Recommended for advanced users only.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.
Edge	Enhancement	→	Off	/	On
You can emphasize object boundaries in the picture.
xvYCC	→	Off	/	On
Setting the xvYCC mode to on increases detail and colour space when watching movies from an external device (ie. DVD player) 
connected to the HDMI or Component IN jacks.

xvYCC is available when the picture mode is set to Movie, and the external input is set to HDMI or Component mode.
This function may not be supported depending on your external device.

Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the items in Picture Options.

Colour	Tone	→	Cool	/	Normal	/	Warm1	/	Warm2	/	Warm3
You can select the most comfortable colour tone to your eyes.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Warm�, Warm� or Warm� is only activated when the picture mode is Movie.
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Colour : 50
Tint (G / R) : G50 / R50

Advanced	Settings		 	 ►
Picture Options
Picture Reset

Picture
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Size
You can select the picture size which best corresponds to your viewing requirements. 

You can select these options by simply pressing the P.SIZE button on the remote control.
Auto Wide: Automatically adjusts the picture size to the ��:� aspect ratio. (New Zealand, Singapore only)
��:�: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
4:�: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cutoff when HDMI (720p / 1080i / 1080p) or Component (1080i 
/ 1080p) signals are input.
Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only ��:� and 4:� mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
screen up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 
the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.
After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the ◄ or 
► button. Use the ▲, ▼, ◄ or ► button to move the picture.
Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the overscan 
function.

Screen	Mode	→	16:9	/	Wide	Zoom	/	Zoom	/	4:3	(New	Zealand,	Singapore	only)
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 
(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 
intended for users to select it.

��:�: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnify the size of the picture vertically on screen.
4:�: Sets the picture to 4:3 normal mode.

This function is available in Auto Wide mode.
This function is not available in PC, Component or HDMI mode.

Digital	NR	→	Off	/	Low	/	Medium	/	High	/	Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.
HDMI	Black	Level	→	Normal	/	Low
You can directly select the black level on the screen to adjust the screen depth.

This function is active only when the external input connects to HDMI (RGB signals).
Film	Mode	→	Off	/	Auto1	/	Auto2
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV1, AV2, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).
Film Mode is not supported in DTV channel with resolution 576p/720p.

Blue	Only	Mode	→	Off	/	On
This function is for AV device measurement experts. This function displays the blue signal only by removing the red and green 
signals from the video signal so as to provide a Blue Filter effect that is used to adjust the Colour and Tint of video equipment such 
as DVD players, Home Theatres, etc. Using this function, you can adjust the Colour and Tint to preferred values appropriate to 
the signal level of each video device using the Red / Green / Blue / Cyan / Magenta / Yellow Colour Bar Patterns, without using an 
additional Blue Filter.

Blue Only Mode is available when the picture mode is set to Movie or Standard.

Picture	Reset	→	Reset	Picture	Mode	/	Cancel
Resets all picture settings to the default values.

Reset Picture Mode: Current picture values return to default settings.
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Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens 
on your PC will probably be different, depending upon your particular version of Windows 
and your particular video card. However, even if your actual screens look different, the 
same basic set-up information will apply in almost all cases. (If not, contact your computer 
manufacturer or Samsung Dealer.)
�. First, click on ‘Control Panel’ on the Windows start menu.
�. When the control panel window appears, click on ‘Appearance and Themes’ and a 

display dialog-box will appear.
�. When the control panel window appears, click on ‘Display’ and a display dialogbox will 

appear.
4. Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution): Optimum-1920 X 1080 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct 
value is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.

Display Modes
Both screen position and size will vary depending on the type of PC monitor and its resolution. The resolutions in the table are 
recommended.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM 640 x 350 31.469 70.086 25.175 +/-
720 x 400 31.469 70.087 28.322 -/+

MAC
640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 960 75.231 74.857 130.000 -/+
1280 x 720 56.456 74.777 95.750 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+
1440 x 900 70.635 74.984 136.750 -/+

1680 x 1050 65.290 59.954 146.250 -/+
VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 

1280 x 1024 74.620 70.000 128.943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN �(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080 or 1600x1200).
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Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Auto Adjustment allows the PC screen of set to self-adjust to the incoming PC video signal. The 
values of fine, coarse and position are adjusted automatically.

Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools	→	Auto	Adjustment.
This function does not work in DVI-HDMI mode.

Screen
Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is 
not removed by Fine-tuning alone, then adjust the frequency as best as possible (Coarse) and Fine-tune again. After the noise has 
been reduced, readjust the picture so that it is aligned on the center of screen.
PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. Press the ▲ or ▼ button to adjusting the Vertical-Position. Press 
the ◄ or ► button to adjust the Horizontal-Position.
Image Reset
You can replace all image settings with the factory default values.
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SOUND CONTROL

Configuring	the	Sound	Menu

Mode	→	Standard	/	Music	/	Movie	/	Clear	Voice	/	Custom
You can select a sound mode to suit your personal preferences.

Press the TOOLS button to display the Tools menu. You can also configure the sound 
mode by selecting Tools	→	Sound	Mode.

Equalizer
The sound settings can be adjusted to suit your personal preferences.
Mode
You can select a sound mode to suit your personal preferences.
Balance
Controls the balance between the right and left speakers.
�00Hz / �00Hz / �KHz / �KHz / �0KHz (Bandwidth Adjustment)
To adjust the level of different bandwidth frequencies
Reset
Resets the equalizer settings to the default values.

SRS	TruSurround	HD	→	Off	/	On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the SRS button on the remote control to select Off or On.

Audio Language (digital channels only)
You can change the default value for audio languages. Displays the language information for the incoming stream.

While viewing a digital channel, this function can be selected.
You can only select the language among the actual languages being broadcast.
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Brightness : 45 
Sharpness : 50

Auto	Adjustment	 	 	 ►
Screen 
Advanced Settings 
Picture Options  
Picture Reset 

Picture

Mode	 :	Custom	 ►
Equalizer
SRS TruSurround HD : Off
Audio Language : - - -
Audio Format : - - -
Audio Description
Auto Volume : Off
Speaker Select

Sound
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Audio	Format	→	MPEG	/	Dolby	Digital	/	Advanced	(digital channels only)
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 
difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

While viewing a digital channel, this function can be selected.
The Audio Format appears according to the broadcasting signal.

Audio Description (digital channels only)
This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 
Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 
Audio Description On or Off and control the volume.
Audio	Description	→	Off	/	On
Turn the audio description function on or off.
Volume
You can adjust the audio description volume.

Volume is active when Audio Description is set to On.
While viewing a Digital channel, this function can be selected.

Auto	Volume	→	Off	/	On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.

Speaker	Select	→	External	Speaker	/	TV	Speaker
If you want to hear the sound through separate speakers, cancel the internal amplifier.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited.

TV’s Internal Speakers Audio Out (Optical, L/R Out) to Sound System
RF, AV, Component, PC, HDMI RF, AV, Component, PC, HDMI

TV Speaker Sound Output Sound Output
External Speaker Mute Sound Output
Video No Signal Mute Mute

Sound	Reset	→	Reset	All	/	Reset	Sound	Mode	/	Cancel
You can restore the Sound settings to the factory defaults.

Reset Sound Mode: Current sound values return to default settings.

Selecting the Sound Mode
You can set the sound mode by pressing the DUAL button. When you press it, the current sound mode is displayed on the screen.

Audio Type Dual � / � Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO	↔	MONO
Dual DUAL	1	↔	DUAL	2 DUAL �

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO	↔	STEREO

Dual MONO	↔	DUAL	1
DUAL � DUAL �

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.
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SETUP

Configuring	the	Setup	Menu

Time
Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.
Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.
Manual: Set the current time to a manually specified time.

Clock Set
You can set the current time manually.

You can set the day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Set up this item when you have set Clock Mode to Manual.

Time Zone (Australia only)
You can select your time zone.

Set up this item when you have set Clock Mode to Auto.
Sleep	Timer	→	Off	/	30	/	60	/	90	/	120	/	150	/	180
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

The TV automatically switches to standby mode when the timer reaches 0.
To cancel the Sleep Timer function, select Off.
Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools → Sleep Timer.

Timer � / Timer � / Timer �
Three different on / off timer settings can be made. You must set the clock first.

On Time: Set the hour, minute, and activate / inactivate. (To activate timer with the setting you’ve chosen, set to Activate.)
Off Time: Set the hour, minute, and activate / inactivate. (To activate timer with the setting you’ve chosen, set to Activate.)
Volume: Select the desired turn on volume level.
Source	→	TV	/	USB: You can select the TV or USB device content to be played when the TV turns on automatically. Select 
TV or USB. (Make sure that an USB device is connected to your TV.)

When there is only one photo file in the USB, the Slide Show will not play.
Antenna: Select ATV or DTV.
Channel: Select the desired channel.
Contents (when Source is set to USB): You can select a folder on the USB Device with music or photo files to be played 
when the TV turns on automatically.

If the folder name is too long, the folder can not be selected.
If the folder name to be configured by the Contents function is too long, it cannot be selected.

Repeat: Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.
When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.

You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer On, the television will eventually turn off, if no controls are operated for 3 hours after the TV was 
turned on by the timer. This function is only available in timer On mode and prevents overheating, which may occur if a TV is 
on for too long time.
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Plug & Play 

Time	 	 	 ►
Game Mode : Off
Child Lock : On 
Change PIN
Parental Lock
Subtitle
Teletext Language : - - -
Preference

Setup
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Game	Mode	→	Off	/	On
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic gaming experience by 
selecting game menu.

Restrictions on game mode (Caution)
To disconnect the game console and connect another external device, set Game Mode to Off in the setup menu.
If you display the TV menu in Game mode, the screen shakes slightly.

Game Mode is not available in TV and PC mode.
If the picture is poor when external device is connected to TV, check if Game Mode is On. Set Game Mode to Off and 
connect external devices.
If Game Mode is On:

Picture Mode changes to Standard and Sound Mode changes to Custom automatically. The user cannot change these to 
other modes.
Sound Mode in the Sound menu is deactivated. Adjust the sound using the equalizer.
The Reset Sound function is activated. Selecting the Reset function after setting the equalizer resets the equalizer setting 
to the factory defaults.

Child	Lock	→	Off	/	On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
You can lock some channels in Channel List. (refer to page 10)
Child Lock is available only in TV mode.

Change PIN
You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0.
If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 
POWER (Off) → MUTE → 8 → 2 → 4 → POWER (On).

Parental Lock
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 
(Personal Identification Number) code that is defined by the user.

The Parental Rating item differs depending on the country.
Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
When the parental ratings are set, the \ symbol is displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.

Subtitle
You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 
and Hard of hearing is the subtitle for a hearing-impaired person.
Subtitle	→	Off	/	On
Switches subtitles on or off.
Mode	→	Normal	/	Hard	of	hearing
Sets the subtitle mode.
Subtitle Language
Set the subtitle language.

If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 
though Hard of hearing mode is selected.
English is the default in cases where the selected language is unavailable in the broadcast.
You can select these options simply by pressing the SUBT. button on the remote control.

Teletext Language
You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.
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Preference
Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 
Primary Teletext Language / Secondary Teletext Language
Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 
channel.
If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language menu are 
automatically changed to the selected language.
The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages supported 
by the current channel and the selection is highlighted. If you change this language setting, the new selection is only valid for the 
current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary Audio Language, or 
the Primary Teletext Language of the Preference menu.

Digital	Text	→	Disable	/	Enable	(New	Zealand	only)
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than
the MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and
video files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields
including VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing,
digital libraries and network games.
At present, the broadcasting station provides EPG content only. Providing more content is scheduled for the future.
If Digital Text is set to Disable, the EPG (Electronic Program Guide) will not work.

Melody	→	Off	/	Low	/	Medium	/	High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the (–) Volume button has been pressed.
When the TV is turned off by Sleep Timer function.

Energy	Saving	→	Off	/	Low	/	Medium	/	High	/	Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools	→	Energy	
Saving.
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INPUT / SUPPORT

Configuring	the	Input	Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Satellite 
receivers (Set-Top Box) connected to the TV. Use to select the input source of your choice.

Press the SOURCE button on the remote control to view an external signal source.  
TV mode can be selected by pressing the TV button.

TV / AV� / AV� / Component� / Component� / PC / HDMI� / HDMI� / HDMI�(DVI) / HDMI4 / 
USB

You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not 
connected will be sorted to the botton. 
PC always stays activated.
Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connecting external devices.
TOOLS (Tools): Displays the Edit Name and Information menus.

Edit Name
Name the device connected to the input jacks to make your input source selection easier.
VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 
/ HD DVD / DMA

When a PC with a resolution of 1920 x 1080@60Hz is connected to the HDMI IN �(DVI) port, you should set the HDMI�/DVI 
mode to DVI PC in the Edit Name of the Input mode.
When connecting an HDMI/DVI cable to the HDMI IN �(DVI) port, you should set the HDMI�/DVI mode to DVI or DVI PC in 
the Edit Name of the Input mode. In this case, a separate sound connection is required.

Configuring	the	Support	Menu

Self Diagnosis
Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Contact Samsung’s call center for assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to 
the external device’s user manual.

Sound Test
If you think you have a sound problem, please perform the sound test. You can check the 
sound by playing a built-in melody sound through the TV.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV 
speaker in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Contact Samsung’s call center for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual. 

Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 
reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 
however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 
Continue to adjust the antenna until you find the best position with the strongest signal.
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Software Upgrade
To keep your product up-to-date with new Digital Television features then software upgrades 
are periodically broadcast as part of the normal Television signal. It will automatically detect 
these signals and display the software upgrade banner. You are given the option to install the 
upgrade.

Current Version shows version of the software being installed in the TV.
Alternative Software shows the previous version that can be replaced.
Software is represented as ‘Year/Month/Day_Version’. The more recent the date, the 
newer the software version. Installing the latest version is recommended.

By USB
Insert a USB drive containing the firmware upgrade into TV. Please be careful to not disconnect 
the power or remove the USB drive while upgrades are being applied. The TV will turn off and 
turn on automatically after completing the firmware upgrade. Please check the firmware version 
after the upgrades are complete. When software is upgraded, video and audio settings you 
have made will return to their default (factory) settings.
We recommend you write down your settings so that you can easily reset them after the 
upgrade.
By Channel
Upgrades the software using the broadcasting signal.

If the function is selected during the software transmission period, this function searches for available software and downloads 
the software.
The time required to download the software is determined by the signal status. 

Standby Mode Upgrade
To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 
slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.
Alternative Software
If Alternative Software is existing, this menu will be activated. You can change the software to previous version.

If software was changed, existing software is displayed.
You can change current software to alternative software by ‘Alternative Software’. 

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV.
Refer to this information when connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software.
You can view the information regarding the call center, product and software file download method.
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MEDIA PLAY (USB)

Connecting a USB Device

�. Press the POWER button to turn the TV on.
�. Connect a USB device containing photo and/or music files to the USB jack on the side of 

the TV.
�. When the Application selection screen is displayed, press the ENTERE button to 

select Media Play (USB).
MTP (Media Transfer Protocol) is not supported.
The file system supports FAT16, FAT32 and NTFS.
Certain types of USB Digital camera and audio devices may not be compatible with this 
TV.
Media Play only supports USB Mass Storage Class devices (MSC). MSC is a 
Mass Storage Class Bulk-Only Transport device. Examples of MSC are Thumb 
drives, Flash Card Readers and USB HDD (USB HUB are not supported.). 
Please connect directly to the USB port of your TV. If you are using a separate 
cable connection, there may be a USB compatibility problem.
Before connecting your device to the TV, please back up your files to prevent 
them from damage or loss of data. SAMSUNG is not responsible for any data file 
damage or data loss.
Do not disconnect the USB device while it is loading.
MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.
The higher the resolution of the image, the longer it takes to display on the screen.
The maximum supported JPEG resolution is 15360X8640 pixels.
For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.
MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) 
is a technology that supports the creation of content, the distribution and management of the content in an integrated and 
comprehensive way, including the protection of the rights and interests of the content providers, the prevention of the illegal 
copying of contents, as well as managing billings and settlements.
When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen. 
If more than one MSC device is connected, some of them may not be recognized. If a device requires high power (more than 
500mA or 5V), the USB device may not be supported. 
If an over-power warning message is displayed while you are connecting or using a USB device, the device may not be 
recognized or may malfunction.

Using the Remote Control Button in Media Play Menu
Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE
Select the currently selected item. While playing a slide show or music file:
- Pressing the ENTERE button during play pauses the play.
- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music.
RETURN Return to the previous menu.
TOOLS Run various functions from the Photo and Music menus.

∫ Stop the current slide show or Music file.
π/μ Jump to previous group/Jump to next group.

INFO Show file information.
MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.
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Media Play Function
This function enables you to view and listen to photo and/or music files saved on a 
USB Mass Storage Class (MSC) device.

It might not work properly with unlicensed multimedia files.

Entering the Media Play (USB) Menu
�. Press the MENU button. Press the ▲ or ▼ button to select Application, then 

press the ENTERE button.

�. Press the ▲ or ▼ button to select Media Play (USB), then press the ENTERE 
button.

The Media Play (USB) menu is displayed.

Press the MEDIA.P button on the remote control to display the Media Play 
menu.

Press the SOURCE button on the remote control to view the source list. 
Then Press the ▲ or ▼ button to select USB.

�. Press the Red button, then press the ▲ or ▼ button to select the USB Memory. 
Press the ENTERE button.
This function differs depending on the USB Memory.
The selected USB device name appears at the bottom left of the screen.

4. Press the ◄ or ► button to select an icon (Photo, Music, Setup), then press the 
ENTERE button. 

To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely
You can remove the device safely from the TV.
�. Press the TOOLS button in the Media Play file list screen, or while a Slide Show or music is being played.
�. Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE button.
�. Remove the USB device from the TV.

Screen Display

Move to either ‘Group List Section’ or ‘File List Section’ using the Up and Down buttons. After selecting a section, press the ◄ or ► 
buttons to select an item.
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1 View Groups: The sort group where the currently selected file is contained is highlighted.
2 Currently selected file: The selected file is the file you can now control. Photo file are displayed as thumbnail images.
3 Current Device: Shows the currently selected device name. Press the Red button to select a device.

Red (Device) button: Selects a connected device.
4 Item Selection Information: Shows the number of files that are selected by pressing the Yellow button.
5 Help Items

Yellow (Select) button: Selects file from the file list. Selected files are marked with a symbol c. Press the Yellow button 
again to cancel a file selection.
TOOLS (Tools) button: Displays the option menus. (The option menu changes according to the current status.)

Photo List Option Menu

�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Photo, then press the ENTERE button. 
�. Press the ◄ or ► button to select the desired photo file.

Selecting Multiple Photos
Press the ◄ or ► button to select the desired photo file. Then press the 
Yellow button.
Repeat the above operation to select multiple photo files.
The mark c appears to the selected photo file.

N
–

–
–

4. Press the TOOLS button.
The option menu changes according to the current status.

Slide Show
Using this menu, you can play a SlideShow using the photo files on the USB memory device.

Play Current Group
Using this menu, you can play a SlideShow using only the photo files in the currently selected sorting group.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The photo file information including the name, the size, the resolution, the date modified and the path is displayed.

You can view the information of photo files during a SlideShow using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Viewing a Photo or Slide Show

Viewing a Slide Show
�. Press the	▼	button	to	select	the	File	List	Section.

�. Press the TOOLS button.

�. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.
All files in the  File List Section will be used for the Slide Show.

During the slide show, files are displayed in order from the currently shown file.
The Slide Show progresses in the order sorted in the  File List Section.

Music files can be automatically played during the Slide Show if the Background 
Music is set to On. 

While a photo list is displayed, press the ∂(Play)/ENTERE button on the 
remote control to start slide show.

SlideShow Control Buttons
Button Operations

ENTERE Play/Pause the Slide Show.
∂ Play the Slide Show.
∑ Pause the Slide Show.
∫ Exit Slide Show and return to the photo list.

π/μ Change the SlideShow playing speed.
TOOLS Run various functions from the Photo menus.

Playing current group
�. Press the ▲ button to move to the Group List Section.
�. Select a group using the ◄ and ► buttons. 
�. Press the ∂ (Play) button. A slideshow begins with the files of the selected 

group.

Alternatively 
�. Select the files In the Photo List Section, contained the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

Only the photos in the sorting group including the selected files will be used for the Slide Show.

To	perform	a	Slide	Show	with	only	the	selected	files
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select the desired photo in the File List.
�. Press the Yellow button.
4. Repeat the above operation to select multiple photos.

The c mark appears to the left of the selected photo.
If you select one file, the Slide Show will not be performed.
To deselect all selected files, press the TOOLS button and select Deselect All.

�. Press the ∂ (Play)/ENTERE button.
The selected files will be used for the Slide Show.
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Alternatively 
�. In the  File List Section, press the Yellow buttons to select the desired photos.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

The selected files will be used for the Slide Show.

Slide Show Option Menu

�. During a slide show (or when viewing a photo), press the TOOLS button to set the 
option.

�. Press the ▲ or ▼ button to select the desired option, then press the ENTERE 
button.

Stop Slide Show / Start Slide Show
You can start or stop a SlideShow.

Slide	Show	Speed	→	Slow	/	Normal	/	Fast
You can select the slide show speed.

This function is available only during a slide show.
You can also change the speed of the Slide Show by pressing the π (REW) or μ (FF) button during the Slide Show.

Rotate
You can rotate photos saved on a USB memory device.

Whenever you press the ◄ button, it rotates by 270˚, 180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 180˚, 270˚, and 0˚. 
The rotated file is not saved.

Zoom
You can magnify photos saved on a USB memory device. (x1 → x2 → x4)

To move the enlarged photo image, press the ENTERE button, then press the ▲/▼/◄/► buttons. Note that when the 
enlarged picture is smaller than the original screen size, the location change function doesn’t work.
The enlarged file is not saved.

Background Music
You can select background music when watching a Slide Show.

To use this feature, there must be music and photo files stored on the USB device.

Background	Music	→	Off	/	On	
Off: Background music is not played.
On: When the background music is available, if you select On, the music is played back. 

Select Music File (0 File(s) Selected)
Only the selected music file is set as the background music.

Picture Setting / Sound Setting
You can select the picture and sound settings.

Information
The photo file information is displayed.

Remove Safely
You can remove the device safely from the TV.
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Music List Option Menu

�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Music, then press the ENTERE button. 
�. Press the ◄ or ► button to select the desired Music file. 

Selecting Multiple Music Files
Press the ◄ or ► button to select the desired music file. Then press the 
Yellow button.
Repeat the above operation to select multiple music files.
The mark c appears to the selected music file.

4.  Press the TOOLS button.
The option menu changes according to the current status.

Play Current Group
Using this menu, you can only play music files in the currently selected sorting group.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The music file information including the name, the size, the date modified and the path is displayed.

You can view the music file information during Play Current Group using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.

Playing Music

Playing	a	music	file
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select a music file to be played.
�. Press the ∂ (Play)/ENTERE button.

This menu only shows files with the MP3 file extension. Files with other 
file extensions are not displayed, even if they are saved on the same USB 
device.
The selected file is displayed at the top with its playing time.
To adjust the music volume, press the volume button on the remote control. 
To mute the sound, press the MUTE button on the remote control.
If the sound is odd when playing MP3 files, adjust the Equalizer and SRS 
TruSurround HD in the Sound menu. (An over-modulated MP3 file may cause a sound problem.)
The playing duration of a music file may be displayed as ‘00:00:00’ if its playing time information is not found at the start of 
the file.
π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons
Button Operations

ENTERE Play/Pause the music file.
∂ Play the music file
∑ Pause the music file
∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.

Music function information icon

p When all music files in the folder (or the selected file) are repeated. Repeat Mode is On.
q When all music files in the folder (or the selected file) are played once. Repeat Mode is Off.
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Playing the music group
�. Press the ▲ button to move to the Group List Section.
�. Select a group using the ◄ and ► buttons.
�. Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 
�. Select the files In the File List Section, contained the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The music files in the sorting group including the selected file are played.

Playing	the	selected	music	files
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select the desired music file.
�. Press the Yellow button.
4. Repeat the above operation to select multiple music files.

The c appears to the left of the selected music file.
To deselect all selected files, press the TOOLS button and select Deselect All.

�. Press the ∂ (Play)/ENTERE button.
The selected files will be played.

Music Play option Menu

Music Play Option Menu

Repeat	Mode	→	On	/	Off
You can play music files repeatedly.

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Information
The music file information is displayed.

Remove Safely
You can remove the device safely from the TV.

Using the Setup Menu
Setup displays the user settings of the Media Play menu.
�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Setup, then press the ENTERE button.
�. Press the ▲ or ▼ button to select the desired option.
4. Press the ◄ or ► button to select the desired option.

To exit Media Play mode, press the MEDIA.P button on the remote control.

Music	Repeat	Mode	→	On	/	Off
Select to repeatedly play music files.

Screen	Saver	Run	Time	→	2	hours	/	4	hours	/	8	hours
Select to set the waiting time before the screen saver appears.

Information
Select to view the information of the connected device.

Remove Safely
You can remove the device safely from the TV.
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ANYNET+

Connecting Anynet+ Devices

What is Anynet+?
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 
remote. The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung 
device has this feature, check if there is an Anynet+ logo on it.

To connect to a TV

�. Connect the HDMI IN (�, �, � (DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

To connect to Home Theatre

�. Connect the HDMI IN (�, �, � (DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

�. Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on 
the Home Theatre.
When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 
Home Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 
DIGITAL AUDIO OUT (OPTICAL) jack on the DVD / Satellite Box (ie Anynet Device 1 or 2) directly to the Amplifier or 
Home Theatre, not the TV.
Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.
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HDMI 1.3 Cable
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Setting Up Anynet+
Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu 
by selecting Tools	→	Anynet+ (HDMI-CEC).

Setup
Anynet+ (HDMI-CEC)	→	Off	/	On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations 
are deactivated.

Auto	Turn	Off	→	No	/	Yes
Setting an Anynet+ Device to turn Off automatically when the TV is Turned Off and setting a TV 
to turn off automatically when a HDMI-CEC device requestes tv to turn off.

The active source on the TV remote must be set to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices
�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Device List, then press the ENTERE button.

Anynet+ devices connected to the TV are listed.
If you cannot find a device you want, press the red button to scan for devices. 

�. Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 
is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the Device 
List menu appears.

Switching to the selected devices may take up to 2 minutes. You cannot cancel the 
operation during the switching operation.
The time required to scan for devices is determined by the number of connected devices.
When the device scan is complete, the number of devices found are not displayed.
Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 
the TV may not always be automatically displayed in the device list. Press the red button to search for the connected device.
If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 
switch to an Anynet+ device by using the Device List.

Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description
View TV Anynet+ mode changes to TV broadcast mode.
Device List Shows the Anynet+ device list.

(device_name) MENU Shows the connected device menus. E.g. If a DVD recorder is connected, the disc 
menu of the DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. E.g. If a DVD recorder is connected, 
the play menu of the DVD recorder will appear.

Recording: (*recorder) Starts recording immediately using the recorder. (This is only available for devices that 
support the recording function.)

Stop Recording: (*recorder) Stops recording.
Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 
menu of the corresponding device is 
displayed on the screen.

Numeric buttons
▲/▼/◄/►/ ENTERE buttons
Colour buttons / EXIT button

After switching to the device, while playing 
a file

π(Backward search) / μ(Forward search) / 
∫(Stop) / ∂(Play) / ∑(Pause)

Device with built-in 
Tuner

After switching to the device, when you 
are watching a TV programme P > / P < button

Audio Device When Receiver is activated Volume / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 
control.
The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, μ operations may differ depending on the device.

Recording
You can make a recording of a TV programme using a Samsung recorder.
�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.
When there is more than one recording device
When multiple recording devices are connected, the recording devices are listed. 
Press the ▲ or ▼ button to select a recording device and press the ENTERE 
button. Recording begins.
When the recording device is not displayed select Device List and press the red 
button to search devices

�. Press the EXIT button to exit.
You can record the source streams by selecting Recording: (device_name).
Pressing the ∏ button will record whatever you are currently watching. If you are watching video from another device, the 
video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 
antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home theatre)
You can listen to sound through a receiver instead of the TV speaker.
�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.
�. Press the EXIT button to exit.

If your receiver supports audio only, it may not appear in the device list.
The receiver will work when you have properly connected the optical in jack of the 
receiver to the DIGITAL AUDIO OUT (OPTICAL) jack of the TV.
When the receiver (home theatre) is set to On, you can hear sound output from the 
TV’s Optical jack. When the TV is displaying a DTV(air) signal, the TV will send out 
5.1 channel sound to the Home theatre receiver. When the source is a digital component such as a DVD and is connected 
to the TV via HDMI, only 2 channel sound will be heard from the Home Theatre receiver.
If there is a power interruption to the TV when the Receiver is set to On (by disconnecting the power cord or a power 
failure), the Speaker Select may be set to External Speaker when you turn the TV on again.
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Troubleshooting for Anynet+

Problem Possible Solution
Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ 

devices only.
Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating  
Plug & Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices 
again or turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●

●
●
●
●
●
●
●

●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ 

(HDMI-CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS 
button to show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than 
Anynet+ devices.
Press P >/<, CH LIST, PRE-CH, and FAV.CH to change the TV mode. (Note that 
the channel button operates only when a tuner-embedded Anynet+ device is not 
connected.)

●
●

●

The message 
‘Connecting to Anynet+ 
device...’ appears on the 
screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a 
view mode.
Use the remote control when the Anynet+ setting or switching to view mode is 
complete.

●

●

The Anynet+ device does 
not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is 
not displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables 
may not support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or 
power cord or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV programme 
cannot be recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not 
output through the 
receiver.

Connect the optical cable between TV and the receiver.●

¦
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RECOMMENDATIONS

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed. 
You can change teletext pages by pressing the numeric buttons on the remote control.

1   0 (mode)
Press to select the teletext mode 
(LIST/FLOF). If you press it in the LIST 
mode, it switches into the List save 
mode. In the List save mode, you can 
save teletext page into list using the 
8(store) button.

2   8 (store)
Used to store the teletext pages.

3   4 (size)
Press to display the double-size letters in 
the upper half of the screen. For lower half 
of the screen, press it again. To display 
normal screen, press it once again.

4   5 (reveal)
Used to display the hidden text 
(answers to quiz games, for example). 
To display normal screen, press it again.

5   Colour buttons 
(red/green/yellow/blue)
If the FASTEXT system is used by a 
broadcasting company, the different 
topics covered on a teletext page are 
colour-coded and can be selected by 
pressing the coloured buttons. Press 
one of them corresponding to the 
required. The page is displayed with 
other coloured information that can be 
selected in the same way. To display 
the previous or next page, press the 
corresponding coloured button.

6   / (teletext on/mix)
Press to activate teletext mode after 
selecting the channel providing the teletext 
service. Press it twice to overlap the teletext 
with the current broadcasting screen.

7   : (exit)
Exit from the teletext display.

8   1 (sub-page)
Used to display the available sub-page.

9   2 (page up)
Used to display the next teletext page.

0   3 (page down)
Used to display the previous teletext page.

!   9 (hold)
Used to hold the display on a given 
page if the selected page is linked with 
several secondary pages which follow on 
automatically. To resume, press it again.

@   6 (index)
Used to display the index (contents) page 
at any time while you are viewing teletext.

#   7 (cancel)
Used to display the broadcast when 
searching for a page.

You can change Teletext pages by pressing the numeric buttons on the remote control. 

The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.
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Installing the Stand

Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 
screws. Applicable to 32inch models only.

N

�. Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

�. Fasten two screws at position 1 and then fasten two screw at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.
The stand is installed for models with the screen size of 37 inch and above.

N
N

N

N

N

Disconnecting the Stand

�. Remove screws from the back of the TV.
�. Separate the stand from the TV.

Two or more people should carry the TV.
�. Cover the bottom hole with the cover.

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself 
or others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.

¦
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Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer.
Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately.
The location of the Kensington Lock may be different depending on its model.

�. Insert the locking device into the Kensington slot on the LCD TV 1 and turn it in the 
locking direction 2.

�. Connect the Kensington Lock cable 3.
�. Fix the Kensington Lock to a desk or a heavy stationary object.

N
N

3

1

2

Securing the Installation Space
Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation. 
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.
Install the product so the required distances shown in the figure are kept.

When using a stand or wall-mount, use parts provided by Samsung Electronics only.
If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the 
product falling.
If you use parts provided by another manufacturer, it  may result in a problem with the product or fire due to an increase in 
the internal temperature of the product due to poor ventilation.

The appearance may differ depending on the product.

When installing the product with a stand■ When installing the product with a wall-mount■
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Wall

Wall

Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your children do 
not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious injuries or death. 
Follow all safety precautions provided on the included Safety Flyer. For added stability, install the anti-fall device 
for safety purposes, as follows.

To secure the TV:
�. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of wall.
Since the necessary clamps, screws, and string are not supplied, please purchase 
them separately.

�. Remove the screws from the centre back of the TV, put the screws into the clamps, and 
then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications

For a 17 ~ 29 Inch LCD TV: M4 X L15 / For a 32 ~ 40 Inch LCD TV: M6 X L15

�. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
cable.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Remove the cable before moving the TV.

4. Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.

¦



N
N

N

N

N
N

N

BN68-01895D.indb   37 2009-04-10   �� 5:27:04



English - �8

Troubleshooting: Before Contacting Service Personnel

Problem Possible Solution
No sound or picture Check that the mains lead has been connected to a wall socket.

Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

Screen is black and power 
indicator light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

No picture or black and white 
picture

Adjust the colour settings.
Check that the broadcast system selected is correct.

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

Blurred or snowy picture, 
distorted sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

‘Check signal cable.’ message is 
displayed

Check that the signal cable is firmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

On PC mode, ‘Not Supported 
Mode.’ message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

The damaged picture appears in 
the corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in the corner of the 
screen. This symptom is caused by external devices, not TV.

The ‘Resets all settings to 
the default values.’ message 
appears.

This appears when you press and hold the EXIT button for a while. The product settings are reset to the 
factory defaults.

You may see small particles if 
you look closely at the edge of 
the bezel surrounding the TV 
screen.

This is part of the product’s design and is not a defect.

The TFT LCD panel uses a panel consisting of sub pixels (6 220 800) which require sophisticated technology to produce. 
However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the 
product.
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Specifications

Model Name LA��B��0 LA40B��0
Screen Size 
(Diagonal) 32 inch 40 inch
PC Resolution
(Optimum) 1920 X 1080 @ 60 Hz 1920 X 1080 @ 60 Hz
Sound
Output 10W x 2 10W x 2
Dimension (WxDxH)
Without Stand
With stand

794 x 77 x 524 mm
794 x 240 x 570 mm

982 x 77 x 626 mm
982 x 255 x 676 mm

Weight
With Stand 13 kg 18 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel 
(Left / Right) -20˚ ~ 20˚

Model Name LA4�B��0 LA��B��0
Screen Size 
(Diagonal) 46 inch 52 inch
PC Resolution
(Optimum) 1920 X 1080 @ 60 Hz 1920 X 1080 @ 60 Hz
Sound
Output 10W x 2 10W x 2
Dimension (WxDxH)
Without Stand
With stand

1116 x 77 x 706 mm
1116 x 275 x 770 mm

1258 x 80 x 798 mm
1258 x 305 x 852 mm

Weight
With Stand 23 kg 29 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel 
(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.
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